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D07 

Investigating Factors that Influence 
Climate  

Adapted from:   My NASA Data Lesson Plans 
http://mynasadata.larc.nasa.gov/preview_lesson.php?&passid=76 

 

Focus on Inquiry 
The students will focus on inquiry by collecting and analyzing climatic data on a specific location, 
constructing and using graphs to analyze the data, and then communicating their observations and 
conclusions to the class. 

Lesson Overview 
Students investigate how latitude and longitude (and distance from the oceans) impact climatic factors such 
as temperature range, average temperature, and precipitation.  Students use the Internet to collect data on a 
specific location, and construct climatograms using Microsoft Excel.  
 

Duration 
4 50-min class periods 

Setting 
Classroom or Computer 
lab 

Grouping 
Groups of 4 

PTI Inquiry Subskills 
3.1, 3.7, 3.8, 4.2, 4.3, 5.2, 5.6, 
5.7, 7.2, 7.3 

 

Lesson Components 
Estimated 

Time 

Inquiry 
Subskills 

Used 

Technology 
Used 

Level of 
Student 

Engagement 
Brief Description 

Engage 
30 

minutes 
  2 

Students use resources to 
research and answer questions 
regarding climate, precipitation, 
and climatogram.  Students 
discuss factors that influence 
climate. 

Explore 
2 class 
periods 

3.1, 3.7, 
3.8, 4.2 

Computer / 
Internet 

3 

Students use Internet to collect 
temperature and precipitation 
data on a specific location and 
construct a climatogram using 
this data. 

Explain 
1 class 
period 

4.2, 4.3, 
5.2, 5.6, 
7.2, 7.3 

Computer / 
Internet 

3 

Students analyze data and 
answer questions regarding 
their findings and present their 
conclusions to the class. 

Expand 
30 

minutes 
5.7 

Computer / 
Internet 

2 

Students discuss and 
investigate other factors that 
influence climate not covered in 
the experiment. 

Evaluate     

Students can be assessed by 
using the answers to the 
questions, the climatograms, 
and their oral presentations. 

Level of Student Engagement 
1 Low Listen to lecture, observe the teacher, individual reading, teacher demonstration, teacher-centered instruction 

2 Moderate Raise questions, lecture with discussion, record data, make predictions, technology interaction with assistance 

3 High 
Hands-on activity or inquiry; critique others, draw conclusions, make connections, problem-solve, student-
centered 

 

National Science Education Standards – Inquiry 
Use appropriate tools and techniques to gather, analyze and interpret data 
Develop descriptions, explanations, predictions, and models using evidence 
Think critically and logically to make the relationships between evidence and explanations 
Communicate scientific procedures and explanations 

National Science Education Standards – Earth Science 
Global patterns of atmospheric movement influence local weather.  Oceans have a major effect of climate, because 

water in the oceans holds a large amount of heat. 
Louisiana Grade Level Expectations – Inquiry 
Gr. 8, Inquiry GLE#7. Record observations using methods that complement investigations (e.g. journals, tables, 
charts) (SI-M-A3) 

http://mynasadata.larc.nasa.gov/preview_lesson.php?&passid=76
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Gr. 8, Inquiry GLE#9. Use computers and/or calculators to analyze and interpret quantitative data (SI-M-A3) 
Gr. 8, Inquiry GLE#6. Select and use appropriate equipment, technology, tools, and metric system units of measurement 

to make observations (SI-M-A3) 
Gr. 8, Inquiry GLE#11. Construct, use, and interpret appropriate graphical representations to collect, record, and report 

data (e.g., tables, charts, circle graphs, bar and line graphs, diagrams, scatter plots, symbols) (SI-M-A4) 
Gr. 8, Inquiry GLE#12. Use data and information gathered to develop an explanation of experimental results (SI-M-A4) 
Gr. 8, Inquiry GLE#13. Identify patterns in data to explain natural events (SI-M-A4) 
Gr. 8, Inquiry GLE#19. Communicate ideas in a variety of ways (e.g. symbols, illustrations, graphs, charts, 

spreadsheets, concept maps, oral and written reports, equations) 
Gr. 8, Inquiry GLE#22. Use evidence and observations to explain and communicate the results of investigations (SI-M-

A7) 

Louisiana Grade Level Expectations Earth Science  
Gr. 8, GLE#24 – Investigate and explain how given factors affect the rate of water movement in the water cycle (e.g., 

climate, type of rock, ground cover) (ESS-M-A10) 

 
Materials List (per group) 

 Computers with Internet access  
 Microsoft Excel or other spreadsheet software  
 Map of North America or Atlas 

 Printed copies of the document:  Using Excel to Construct Climatograms 

 
Advance Preparation 

1. Gather materials necessary to complete lab.  It may be helpful to run through the document 
(http://mynasadata.larc.nasa.gov/docs/climatograms-excel-instr.doc) and construct a climatogram 
so you are prepared to answer questions if students run into problems. 

2. Before implementing the lesson with students, it is strongly recommended that you check to see 
that the browser being used is compatible with the Live Access Server, and that the pop- up 
blockers are turned off. 

 

Other Information 
Learning Objectives 

 To employ inquiry methods to investigate how latitude and longitude (and distance from oceans) 
impact climatic factors such as temperature range, average temperature, and precipitation. 

 
Prior Knowledge Needed by the Students 

 An Introduction to the Live Access Server  
 Familiarity with Excel or other spreadsheet program 

 
Procedure 
 
Engage   
 
Part 1 – Background Information 

1. Provide the students with the My NASA Data glossary 
(http://mynasadata.larc.nasa.gov/glossary.php), an Earth Science textbook, or library resources to 
answer the nine questions contained in Part 1 of their Blackline Master 1. 

2. Form groups of 4 and have students discuss their answers and then discuss the answers as a 
class. 

3. Explain to the class that there are several factors that influence the climate or prevailing weather 
conditions for any given location on Earth. The most important factor is the latitude of the location 
because that affects the amount of solar radiation received throughout the year. For example, at 
the Equator, the amount of solar radiation is fairly constant year-round, but as you head toward the 
poles, the amount of solar radiation varies by season. Other factors include its distance from a 
body of water (its moisture source), elevation and local topography. 

4. Explain the activity to the students:  In this activity, you will create climatic diagrams called 
climatograms that allow you to display monthly average weather conditions such as temperature 
and precipitation at a particular location. You will then use the data to design an investigation about 
the factors that influence climate. 

 

http://mynasadata.larc.nasa.gov/docs/climatograms-excel-instr.doc
http://mynasadata.larc.nasa.gov/docs/climatograms-excel-instr.doc
http://mynasadata.larc.nasa.gov/glossary.php
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Explore     
  

Part 2 – Download My NASA Data microsets and perform calculations 
1. Assign a location (latitude and longitude) to each group of students, or let them choose a location, 

but be sure that the locations are evenly distributed from the entire North American continent along 
lines of latitude and longitude.   

2. To determine an even distribution, use a large map of North America. (An overhead transparency 
or a plain labeled grid could substitute for the map.)  

3. Using a black marker, draw 10 degree by 10-degree grids on the map (130W to 70W and 30N to 
60N). This will give you 30 data points. 

4.  Assign one data point per group. This can be done by assigning each student a specific latitude 
and longitude, or by allowing students to choose their own point using a post-it adhered to the map.  

5. Have students work through Part 2 on their Blackline Master 1.  Make sure computers are 

connected to the NASA Live Access Server 
(http://mynasadata.larc.nasa.gov/las15/servlets/dataset) and that pop-up blockers are turned off.  
Note that the Excel directions may vary based on the version of Excel you have on your computer. 

 
Part 3 – Construct a Climatogram 

1. Have students work through Part 3 on their Blackline Master 1. 

2. Hand out printed copies of the document: http://mynasadata.larc.nasa.gov/docs/climatograms-
excel-instr.doc.   Note:  These directions may vary based on the version of Excel you have. 

 
Explain 
 

Part 4 – Questions and Oral Presentations 
1. Have students present their findings orally to the class. 
2. Ask each group or the class as a whole:  What factors in this investigation influence climate and 

how is climate affected by each? 
3. Discuss answers to questions and activity conclusions found under Part 4 of the Blackline Master 

1. 

 
Expand  

1. As a class, discuss each of the factors that influence climate and lead into topics such as solar 
intensity, seasons, wind belts, elevation, topography and ocean currents which were not addressed 
by this investigation.  How would these factors have altered the experiment?  Would any of these 
factors cause you to revise your interpretation or conclusion? 

 
Evaluate 

1. Students can be assessed by using the answers to the questions on the Blackline Master 1, the 
resulting climatograms, and their oral presentations. 

 
Blackline Masters 

1. Identifying Factors that Influence Climate (pages 1-5) 

 
Supplementary Resources 
 
Credits 
Lesson plan contributed by Denise Thompson, Orting, Washington 

Investigating Factors that Influence Climate 

 

http://mynasadata.larc.nasa.gov/las15/servlets/dataset
http://mynasadata.larc.nasa.gov/docs/climatograms-excel-instr.doc
http://mynasadata.larc.nasa.gov/docs/climatograms-excel-instr.doc
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Name:  ________________________________________________ Date:  ____________ 
 

Investigating Factors that Influence Climate 
 
Procedure 
 
Part 1 – Background Information 
 
Using the resources provided to you, answer the following 9 questions: 

 
1. What is the difference between climate and weather? 

_______________________________________________________________________________
_______________________________________________________________________________
_______________________________________________________________________________
_______________________________________________________________________________ 

 
2. Describe what an average temperature, temperature range and precipitation are.  

_______________________________________________________________________________
_______________________________________________________________________________
_______________________________________________________________________________
_______________________________________________________________________________ 

 
3. List at least three possible forms of precipitation. 

1. ____________________________________ 
2. ____________________________________ 
3. ____________________________________ 
 

4. Sketch an example of a climatogram. 
 
 
 
 
 
 
 
 

5. What information can be found on a climatogram? 
_______________________________________________________________________________
_______________________________________________________________________________
_______________________________________________________________________________
_______________________________________________________________________________ 

 
6. What information cannot be found on a climatogram? 

_______________________________________________________________________________
_______________________________________________________________________________
_______________________________________________________________________________
_______________________________________________________________________________ 

 
7. What variables are plotted on each axis of a climatogram? (remember the units) 

_______________________________________________________________________________
_______________________________________________________________________________
_______________________________________________________________________________ 

 
8. Why are there two y (vertical) axes in a climatogram? 

_______________________________________________________________________________
_______________________________________________________________________________
_______________________________________________________________________________
_______________________________________________________________________________ 

 

Blackline Master #1, pg. 1 
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9. What information do you need in order to make your own climatogram? 
_______________________________________________________________________________
_______________________________________________________________________________
_______________________________________________________________________________
_______________________________________________________________________________ 
  

Part 2 – Download My NASA Data microsets and perform calculations 
1. You should have been given or chosen a specific location (latitude and longitude) in North America.  

Record the latitude and longitude here: 
 
Latitude: _______________________ Longitude: ______________________ 
 

2. Your computer should be connected to the NASA Live Access Server (LAS):  
http://mynasadata.larc.nasa.gov/las15/servlets/dataset. 

3. Click the Water link, and then check the box next to Monthly Precipitation (CMAP).  Click Next. 
4. Enter the following parameters: 

Select view:  Time series (t) 
Select output: Table of Values (text) 
Select region:  North America  

5. Type in your specific latitude and longitude in the boxes to the right of the map. 
6. Select time range Jan 1994 through Jan 2005.  Click the Next link. 
7. The data should be displayed in a new window.  Save this data by printing it or clicking File  Save 

As.  Enter “Your Location Name + Precipitation” (for example, “Southern California Precipitation”) 
as your file name and save it to your desktop or another specified location.  This will be your 
Precipitation dataset.  Close this pop-up window only. 

8. Go back to the main page:  http://mynasadata.larc.nasa.gov/las15/servlets/dataset. 
9. Click the Land link, and then check the box next to Monthly Surface Clear-Sky Temperature 

(ISCCP).  Click Next. 
10. Repeat steps 4-6, entering the same data as above.   
11. The data should be displayed in a new window.  Save this data by printing it or clicking File  Save 

As.  Enter “Your Location Name + Temperature” (for example, “Southern California Temperature”) 
as your file name and save it to your desktop or another specified location.  This will be your 
Temperature dataset.  Close this pop-up window only. 

12. Open Microsoft Excel and import your two datasets.  Note:  These directions may vary based on 
the version of Excel you have. 

a. Go to the Data tab, and click the “From Text” option. 
b. For Files of Type, navigate to the Desktop or to the folder where you saved your data.  

Select All Files from the drop down list and find your Precipitation file.  Click Import. 

c. For Start import at Row, enter 59.  Click Next. 
d. Under Delimiters, make sure Space is selected.  Click Next. 
e. Click Next.  Click Finish. 
f. If Column A is full of blank data, highlight the column, right click, and click delete.   Do the 

same for Column B (full of 0’s) and Column C (full of backslashes).  All you need is the 
time column (i.e. 1-Jan-94) and the Precipitation column (i.e. 1.34).  All other columns can 
be deleted.  So you should only have data in Columns A and B after formatting. 

g. Calculate a precipitation average for each month for the entire data spread. Note: It may 
be easier to calculate if you first line up each year's data side by side instead of in one 
long column.  So you can rename Column A “January” through “December” and then copy 
each year’s data next to it.  In the last column, calculate the average. 

h. Now go to Sheet 2 of the worksheet. 
i. Repeat steps a and b except this type find your Temperature file. 

j. For Start import at Row, enter 57.  Click Next. 
k. Under Delimiters, make sure Space is selected.  Click Next. 
l. Click Next.  Click Finish. 
m. If Column A is full of blank data, highlight the column, right click, and click delete.   Do the 

same for Column B (full of 0’s) and Column C (full of backslashes).  All you need is the 
time column (i.e. 1-Jan-94) and the Temperature column (i.e. 287.8).  All other columns 
can be deleted.  So you should only have data in Columns A and B after formatting. 

n. Calculate a temperature average for each month for the entire data spread. Note: It may 
be easier to calculate if you first line up each year's data side by side instead of in one 

Blackline Master #1, pg. 2 

http://mynasadata.larc.nasa.gov/las15/servlets/dataset
http://mynasadata.larc.nasa.gov/las15/servlets/dataset
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long column.  So you can rename Column A “January” through “December” and then copy 
each year’s data next to it.  In the last column, calculate the average. 

o. Now, go to Sheet 3 of the worksheet.   
p. On Row 1, Enter “Time” in Column A, “Avg Precipitation” in Column B, and “Avg 

Temperature” in Column C.   
q. Copy the Avg Precipitation and Avg Temperature columns from Sheets 1 and 2 into these 

two columns in Sheet 3.  You may have to right click and choose “Paste Special” and 
select “Values and other formats” to paste successfully.  Format these columns so the 
data has two decimal points. 

r. Save this file as “Your Location Name + Climatogram” (for example, “Southern California 
Climatogram”). 

s. Temperature data may be converted from Kelvin to degrees Celsius or Fahrenheit, if 
desired. 

Here is an example of a sample table: 
 

 
 

Part 3 - Construct a Climatogram 
1. After you have completed your calculations, you are ready to construct the climatogram using the 

standard climatogram axes.   
2. Refer to the document “Using Excel to construct Climatograms” (found here: 

http://mynasadata.larc.nasa.gov/docs/climatograms-excel-instr.doc).   
3. Follow the directions on this document to construct your climatogram.  Do not forget to label the 

title, axes and units!  Save your climatogram, and if possible, print your climatogram to share with 
the class. 
Note:  These directions may vary based on the version of Excel you have.  If you can’t find the 
options listed in the document, highlight the data you want to graph, go to the Insert menu, and 
select the “Line” option in the Charts area.  Then, manually add the labels by using the options on 
the Layout menu.  To create a secondary axis, in the chart, click the data series that you want to 
plot on a secondary vertical axis.  On the Format tab, in the Current Selection group, click Format 
Selection.  On the Series Options tab, under Plot Series On, click Secondary Axis and then click 
Close. 
Here is an example of a sample climatogram: 

Blackline Master #1, pg. 3 

http://mynasadata.larc.nasa.gov/docs/climatograms-excel-instr.doc
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4. Summarize your data using words and numbers. 
a. Use the maximum temperature and the minimum temperature to calculate the 

temperature range. Record on your climatogram. 
b. Calculate the average temperature for your climatogram. Record. 
c. Calculate the average total yearly precipitation for your climatogram. Record. 
d. Use words to describe the trends that you observe in your climatogram. Be sure to 

describe any seasonal differences and the months that they occur. 
 

Part 4 – Questions and Oral Presentations 
1. As a group, answer the questions 1-4 below. 
2. Then, using the information collected including your resulting climatogram, write a paragraph 

conclusion or final summary for the activity in the space provided below. 
3. Present your findings orally to the class. 

 

Questions: 
 
1.  Why did you have to download 11 years of data from the LAS? Wouldn't one year of data have worked 
just as well? 
 

  _____________________________________________________________________________________ 

 

  _____________________________________________________________________________________ 

 

  _____________________________________________________________________________________ 

 

2.  Are the averages that you calculated considered weather or climate data? Explain your answer. 

_____________________________________________________________________________________ 

 

_____________________________________________________________________________________ 

 

Blackline Master #1, pg. 4 
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3.  Discuss the accuracy of your climatogram. 

_____________________________________________________________________________________ 

 

_____________________________________________________________________________________ 

 

4.  What are the strengths and weaknesses of using a climatogram to model climate? 

 
  _____________________________________________________________________________________ 

 

  _____________________________________________________________________________________ 

 

Conclusion:   
 
_____________________________________________________________________________________ 

 

_____________________________________________________________________________________ 

 

_____________________________________________________________________________________ 

 

_____________________________________________________________________________________ 

 

_____________________________________________________________________________________ 

 

_____________________________________________________________________________________ 

 
_____________________________________________________________________________________ 

 

_____________________________________________________________________________________ 

 

_____________________________________________________________________________________ 

 

_____________________________________________________________________________________ 

 

_____________________________________________________________________________________ 

 

_____________________________________________________________________________________ 

 

Blackline Master #1, pg. 5 


